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From the President

Tammy Graham, TPPA President

We’re All About “Networking”

With Texas School on our doorstep and Summerfest just waiting in the wings, | thought this would be a good time to
talk about one of the unwritten benefits of your TPPA membership... “Networking.™

Networking: NOUN
1.a supportive system of sharing information and services among individuals and groups having a common interest:

It 1s impossible to put a price on the value of making connections within TPPA. When you participate in a TPPA event,
you not only get education from speakers and instructors, but you also have the opportunity to learn from other TPPA

members. At any given event, there are those in attendance who share the same struggles as you, have been where you are
and have overcome difficult situations or hold a solution that will change the course of vour business.

There is also a good chance that you might be the voice that a fellow member needs to hear. You can be the voice of
encouragement, provide sound advice, or simply share how yvou work around common obstacles.

How many of you look forward to seeing great friends at an event? Chances are you first met those friends at a TPPA
event and have become lifelong friends. This still happens at every TPPA event. Now, you might be skeptical at how this
would happen among competitors at an event. You may wonder why anyone would share their business insights with
someone they do not know. You may even feel a bit protective of your own “trade secrets.” These are common feelings
with those who are new to the association world. The trick 1s to move past those fears and get plugged in. Members who
embrace the message of sharing soon realize that we are all better when all photographers are strong.

The hard part of all of this 1s that networking 1s not intuttive. It requires deliberate action to take place. Whether you are
new to TPPA or you are a long-time member, networking begins with you! For example, 1f you are attending an event for
the first time, you should make a point to introduce yourself to people and let them know vou are new to TPPA. Make
sure you carry some business cards with you to exchange with people you meet and follow up with a simple email letting
them know you enjoyed meeting them. Ask for advice on making the most of the event... “Where is a good place for
lunch?” or “Which speakers are you looking forward to hearing?” These are great questions to start a conversation.

If you are a seasoned TPPA member, make sure to reach out to those you do not know. Don’t pass by individuals sitting
or standing by themselves without saying hello or asking them if they have any questions. Try to invite someone new to
lunch or to sit with you in a program. Go out of your way to make everyone feel welcome.

We are all part of the TPPA family who are working to improve our craft, grow our business, and find new solutions to
becoming more efficient. The fact that TPPA members are willing to share ideas and build each other up 1s one of the
things that makes TPPA such a special orgamzation. | am thrilled that you are part of our growing association.

Tammy Giraham
TPPA President

If you are not a member of Texas PPA, this is my personal invitation to you to join!
Email Steve Kozak, TPPA Executive Director, at Steve@tppa.org or call 972-601-2070.
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NEED ANOTHER GOOD REASON
TO JOIN TEXAS PPA?

STEVE KOZAK
TPPA EXECUTIVE DIRECTOR

he Texas Professional Photographers Association is excited to

bring vou an exclusive FREE member benefit program provided by
Office Depot and OfficeMax that 1s not available to the general public.
As a member of Texas PPA, you can save up to 80% on thousands of
items.

Members will receive a “TPPA Store Purchasing Card™ which can
be used at any Office Depot or OfficeMax store location. Simply
present it to the cashier upon checkout. All available discounts will
be immediately applied to your purchases and your savings will be
displayed on your receipt.

To shop online or to print out additional Store Purchasing Cards, visit
officediscounts.org/tppa. Qualifying online orders of $50 or more are
eligible for next business-day delivery to your home or office. Visit the
website for more details.

Officeperor |,

OfficeMax

STORE PURCHASING CARD |
SPC # 00000000000

John Doe

Your card never expires and can be used for personal or business
purchases of thousands of eligible program items such as ink and toner,
paper, cleaning and breakroom supplies, and even furniture!

We have already heard from members who have shared stories of real
savings from using the card. A TPPA member in Waco said she saved 50%
on her total order. Personally, | recently saved $20 on a box of envelopes
that [ buy about 5 times a year. That savings alone is enough to cover my
entire TPPA membership!

The card also works in the Copy and Print Department. Black and white
copies that are normally around $0.12 will be reduced to less than $0.03
per copy with your TPPA Store Purchasing Card. Savings are even greater

with color copies.

We hope that you take advantage of this exciting new program!

Office pEPOT

EXCLUSIVE BENEFITS

You can now shop at Office Depot and OfficeMax oronline to
receive discounts offered through Texas PPA.
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GETTING UNCOMFORTABLE

The Best Place To Be As An Artist

JT Blenker, Photog.Cr., CPP

veryday you have the choice to be content with things simply happening to you, or choosing to make things happen. The

latter tends to make me happier even when it definitely 1sn’t as easy. In June 2017, storms were everywhere across Texas. into
Oklahoma, south into Mexico, and finding a location to shoot astrophotography and wide angle night sky photos with a new moon
were all blocked by cloud cover. I was checking every weather and astronomical forecast to see 1f anything would clear up and a tiny

place in the panhandle of Texas was clear; Caprock Canyons State Park. I had been to Caprock Canyons before and was not excited
one bit.

ApriMay 2018 THE PHOTOGRAPHER




-

Caprock Canyons 15 a beautiful area with large outcroppings of rock and very dark
skies, but 1t has some things that make 1t kind of tough to shoot for a nightscape

image. It has quite a bit of traffic with campgrounds fairly close to some of the best

rock formations. Everyone (and I mean everyone) has their flashlights on, cars are

driving 1n and out into the early hours of the morning, and vou have, usually, a few
people light painting areas of the park. As a photographer that shoots a ton of night

landscapes it’s everything | try to avoid. ... and then there are the snakes.

I knew that | wanted to shoot an arched Milky Way image and would have to
figure out a composition, hike in, set up, and be ready to shoot within about

90 minutes of arriving. Oh, and set up 2 time-lapse rigs quickly as well so no
pressure. Spoiler, the time lapses didn’t happen. | scouted the South Prong and
hillside areas quickly, took a pretty good guess at where two images would
eventually line up well and the timeline for both, and threw my cameras and
equipment into my folding wagon and started walking into the snake infestation
that 1s the Caprock Canyon trails.

It’s currently about 30 minutes before sunset and the surrounding landscape has
already blocked the rays of the sun and the trail I am moving down keeps getting
lower and lower, and I haven’t exactly checked the trail maps, but after walking
about 15 minutes and dropping down into a ditch about 25-30 feet in elevation
below where the trail head was | am finally starting to walk up a hill. I can just
start to see the composition | want, but the height on the trail 1s too low, but there
15 a hill to my right though that adds another 10-15 feet, the ideal height for the
mmage | am thinking of creating. This perfectly placed hill is full of cactus, and
what look like gopher holes. They are most definitely not gopher holes. [ cry a
little on the inside and very carefully make my way up the hill with my bag and
tripod and leave the wagon on the trail just within eyesight. I refuse to travel the
20 or so feet for anything in that wagon. The “gopher holes™ have kept me from
attempting any time lapses for the might.

Throughout the next 3 hours, | operate within about a 4 foot circle around my
tripod and keep a sustained watch around my tripod checking with my red head
lamp light for any movement or new “sticks™ that have moved closer to me. | took
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“Star Bridge To Caprock”
by JT Blenker

this composition with 3 different lenses to maximize my chances of putting
this large of a panoramic together. The final image is 3 rows of imaging
high and in total came to 136 total images all with about 60 percent
overlap. | was worried that either the sky would not stitch or the foreground
due to two things: | wanted this to be shot with a 50mm lens on a full frame
because the detail would be awesome, but going this large is a pain with so
many images for the scene. Secondly, those people driving into the canyon
and flashing their lights on and off in their camps are randomly lighting up
the canyon rocks everywhere.

To convince the viewer of a scene you need consistency in the light
direction and intensity. If this is not correct a plausible image will have
lighting 1ssues and loses much if not all of its impact. | wanted to create the
foreground with the moon acting as a main light and illuminating the rock
face, and adding dimension and a ratio with the ambient starlight. | had

to reshoot several foreground areas a few times, and as this 1s happening
the moon 1s getting lower and less intense. | finally took enough equally
exposed images for the foreground that [ felt I could raise or lower the
exposure a few tenths of a stop and not lose the believability of the image.
Finally, the moon set behind the ndge.

About 30 minutes after the moon has set [ can begin imaging the sky and
stars. | dug into my bag and started shooting with several different lenses,
again to cover my bases in case stitching with the 50mm lens failed.
Thankfully, the 50mm with the 60 percent overlap did the trick and the
only 1ssue was the amount of images. | photographed quickly, as the sky

15 constantly moving and within an hour this composition had already
changed. When the sky imaging was finished | was only thinking about
two things: this nightscape 1s going to look awesome! But, mostly 1 was
thinking; I'm about to get bit by a snake climbing down this hill. After
slipping some and falling once | made it down to my wagon and started
heading back up the trail with my equipment while walking with incredible
mtention and attention to every detail on the ground in front of me. For the
first time in Caprock Canyons [ didn’t see a single snake.




I was able to capture another series of images for a different panorama image
(right) in the early morning hours and finally drove home. I would not have
come to Caprock Canyons State Park and created Star Bridge To Caprock

if the weather wasn’t terrible everywhere else. | wouldn’t have been in the
panhandle of Texas 1f every previous new moon weekend was just abhorrent
for star imaging with rain and cloud cover. | wouldn’t have gone out to Caprock
Canyons if plane tickets were a hittle cheaper. | wouldn’t be so excited about
how this image turned out if | had said, “Screw 1t!” and stayed home.

I’m happiest and | grow the most when | get outside my comfort zone. | think
every artist should get a little uncomfortable and be okay stretching themselves.
You will grow as a person and as an artist if you do, and you just might
experience something extraordinary in the process.

A simple way to begin learning to shoot panorama night images 1s to begin
during the day. | like starting off with a 24mm lens equivalent on a full frame,
an L bracket so your camera can be vertical, and a simple tripod with a ball
head. This technique may have some issues with stitching if you have too much
foreground in front of you with a mid-ground element large in the frame. This
can be fixed by adding a nodal slide to move the camera so there is no parallax
in the images. By simply shooting a six to eight image panorama from left to
right, you can now take advantage of reducing the amount of noise in your
night photography. Simply, you can trade the greater amount of megapixels
and therefore detail for noise reduction. The image below is a simple six image
panorama photographed vertically across without any blending or additional
compositing beyond putting the panorama together.

Nightscapes and astrophotography can be very in depth but it 1s also an
incredible amount of fun to learn and achieve great results. | also use a number
of portrait photography ideas in my imaging because it simply adds to the final
image by being intentional in the image I'm creating. | credit those processes to
CPP and it’s another tool that | can use every time | photograph and create.

“Berween Night And Day” by JT Blenker

Six images (above) were used to create
a breathtaking panoramic image of
“Stars and Fire Over Yellowstone Falls"”
by JT Blenker (left).

JT Blenker is a Photographic Craftsman
and Certified Professional Photographer
with Professional Photographers of
America. He leads astrophotography
and landscape workshops throughout
the United States with a focus on the
National Parks. JT is also the Director
of Communications at the Dallas
Professional Photographers Association
and is speaking throughout the USA in
2018 about photography. the night sky.
and becoming who we are meant to be.

ApriMay 2018 THE PHOTOGRAPHER




mneann

Nikon D850 Body - *3,299™

Canon 5D MIV - In Stock

Ll Ll

Sony a7R Il - In Stock

Panasonic GHS - In Stock

=
—
- -
=
s - | i
- . -
v m i : i :
e S E:l
'HH e W 4 -
o o
;ﬁ:ilt ]
. oy ¥ &
B . - - - 5 il
A |
L ’5' ':“gn-r/ S—
- - T
S-E~cp-sgu~ om : - e
- v - “"._'.-I_., r
4 - ~* . B !
;-ﬂin-lll- o = ‘ ":"'..
giTSoIEtSEIE ek
= :"'. "::_ - = ¥

Olympus EM1 MII - In Stock

Fujifilm X-T2 - In Stock

2 g
!

*Must mention ad at checkout o receive credit.

2438 W. Anderson In & Bume R & A MERA & VIDEO
M-F: 10-7 Sat: 10-6 Sun: 1-5 www.precision-camera.com



WILDLIFE

PHOTOGRAPHY

Inspiration from Home

by JOE MCDONALD

y wife and I are lucky enough to travel the world leading wildlife photo tours and safaris, a job and life-style that has us on the road at least

30 weeks each year. Serious wildlife and nature photographers tied to jobs at home where vacation time and travel budgets are limited may be
envious of that type of schedule. Some may feel frustrated by having less glamorous wildlife subjects accessible to satisfy their passion. I'd like to
suggest that anyone feeling this way shouldn’t, as some of the most productive photography you may ever do can be had within miles of your home.

Doubt that? Check various photo websites and look critically at the posted images.
You’ll be astounded, and humbled, too, by the quality of the work and the sheer
vision displayed with photos of American wildlife, more ofien than not shot by
photographers working locally. There’s a valuable lesson here, and that is you don’t
have to travel to exotic locations to make great photos.

I’'m often asked where I most enjoy photographing and my answer always surprises.
It is: Home. I love to work locally, as this gives me time to explore, to try new
techniques, to redo and redo and redo, if necessary, a particular photo project until

I get it right. Now, you might be asking yourself why any pro would need to redo
and redo a shoot, but as I mentioned in a previous article in The Photographer 1

do a lot of camera trap work where 1 never know what I'll get. Often, I have little
control over my subject’s direction or pose. It is a lucky day when everything comes
together on the first attempt.

12

But photographing around home truly does inspire me. I look
forward to the first warm days in Spring when the vernal ponds on
my property fill with Wood Frogs, drawn here to mate and lay their
eggs, an event that may last only a few days. The arrival of Spring
in central Pennsylvania is unpredictable, sometimes arriving in early
March, sometimes not until mid-April, and more often than not I'm
not inside the state when the frogs put on their show. But I hope to
be. and I'm always planning some new way to capture an event ['ve
witnessed off-and-on for over twenty-five years.

I am fortunate to live in a rural area, with plenty of farm fields,
woodlots, and a track of forest that starts at my studio and continues
further than I'll ever see. Each habitat offers its own special
treasures. One day in late Spring I noticed a Bobolink, a colorful but

ApriMay 2018 THE PHOTOGRAPHER




“I love to work locally, as this gives me time to explore, to try new techniques, to redo and redo and redo,
if necessary, a particular photo project until I get it right.” Joe McDonald

uncommon bird mid-state, flutter to a weed stalk in a neighbor’s pasture.
Days later, after obtaining permission from the farm owner, I was sitting
inside a blind, framing that Bobolink inside my lens. To me, photographing
that bird was more exciting than most any bird I've shot on foreign trips, as
I"d only had far-off views of Bobolinks before, and those were many years
ago. 1 can still see in my mind’s eye the first Bobolink I ever saw, and ever
since | lusted — yeah, that’s the word — for a chance to photograph one.

Just a few days ago | learned that a Bald Eagle perched regularly on a dead
snag within sight (via a spotting scope) of my front porch. Again, after
getting an okay from the land owner, I set up a blind, and when the weather
finally cooperates, I planned on being inside, hoping the eagle pays a visit.
This opportunity prompted me to call one of my photo buddies and declare a
somewhat cryptic message on his answering machine, °I love where I livel”
As 1t turned out, the Bald Eagle wandered elsewhere and, with a six-week
trip to Africa looming, 1 had to take down the blind. I'll try again when I
have another stretch of time at home.

If my past experiences are any indication, I think we sometimes take for
granted the photo opportunities we have around us close to home. I know

I have, and I have lived to regret it. One of my biggest regrets, ever, was
not taking more time to photograph a Belted Kingfisher nesting on a stream
bank within 100 yards of my home. True, I did spend some time in my

A |

\ )

/
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photo blind and I did get some nice images. but I could have explored this
subject — one of the wariest birds in North America — in far greater detail.
I made the mistake of thinking I'll just do more shooting during the next
nesting season, which never happened as the birds did not return!

In my previous article I explored the potential camera traps had for making
unique images, and this type of work is perfect for local photography.

You might be amazed what you can capture in your own backyard garden.
Friends of mine who live in Texas complain about the Armadillos that
frequently tear up their yard but someone living outside this unique
mammal’s range, 1'd love to have the chance to photograph one. Many years
ago, a National Geographic captured an outstanding image of an Armadillo
in mid-jump — when frightened, these armored, prehistoric-looking critters
often bound straight up into the air — and [ can still picture that armadillo in
my mind.

In my neck of the woods Chipmunks can be a problem, chewing into the
wires or linings of a parked car, or into and through a screen door, and

many homeowners sharing their woodland habitat with this attractive rodent
consider them a pest. I don’t, and one of my summer projects a year or so
ago was to capture an Eastern Chipmunk 1in mid-leap. I succeeded, but 1
must admit that the project took several days. The story on how I succeeded
might be nstructive and motivational.
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Just outside my studio in the woods I have an 8x12 elevated water set, that
stands about chest high. Elevated as it is, I can shoot from a water-level
position without lying down and instead I can stand or sit and still have a
duck’s eye view. Preparing for this shot I baited opposing sides of the water
set with sunflower seeds, and sprinkled a couple of seeds on a series of stones
I placed between the two bait sites. Chipmunks and Gray Squirrels quickly
learned that the fastest way to either seed cache was across the stones. Over
the span of a few days I lengthened the distance between two of these rocks,
forcing these rodents to jump as they traveled from one feeder to another. All
that was the easy part.

Chipmunks and squirrels would visit the water set at varying times of the
day and I didn’t have the time to sit and wait for my subjects to appear. Quite
frankly, 1 also knew I would not have the reaction time necessary to catch a
chipmunk in mid-leap if I was waiting behind the camera. By using a camera
trap, however, I knew I could get the shot ... or so [ thought. It turned out it
wasn’t quite that simple.

As 1 discussed previously, lag time is an issue when using a camera trap, and
my chipmunks were completing their jumps before the camera fired. I tried
repositioning the infrared beam of my RangelR closer to their launching point,
but that didn’t work, either. Either the chipmunks would lean forward just far
enough to break the beam before they jumped, or they’d start their jump early,
and still be on the next rock before the camera fired. Nothing seemed to work,
whether I changed the distance between one stone and the next or repositioned
the infrared beam, the chipmunks defeated my every effort.

1 finally succeeded when I switched to an external high-speed shutter, made
by Cognisys, the same company that manufactures the RangelR and the Sabre
infrared triggers. This shutter system has a nearly instantaneous response time
—about 1/200th of a second, fast enough that I could now position the infrared
beam mid-way between the two stones and be certain I'd catch the Chipmunk
as it was crossing. And it worked.

Now you might be thinking that’s a lot of time and effort for a darn rodent, and
I would agree with you, but I must say it was a fun project, and it did result in

some novel shots of an animal we often overlook or take for granted. Just as we I've certainly done my time stalking insects and spiders around our
often do with bugs, another common and diverse subject providing imaginative garden and the surrounding fields with a macro lens, and I'd really like
photographers the opportunity to make some pretty interesting and unique to do more of this type of photography and exploration if I could just
images. take the time. I rarely have that time. However, once again by using a

camera trap I can take some very unique insect photographs while I'm
doing something else. It’s actually fairly easy.

As you all probably know, insects are attracted to lights at night,
and insects don’t just fly into a light, they swirl and mill about,
etching figure eights and loops that can be mesmerizing. All

of this circling centered around a light makes catching a flying
insect with a beam a real possibility. The setup is pretty easy,
although you’re likely to be firing off a lot of images to land a

good one.

In the last article I discussed lag-time, the delay between when

a beam is tripped and when a camera actually fires. Fortunately,
lag-time isn’t an issue here since I'm shooting flying insects at
night. I connect a flash to the RangelR instead of connecting

to a camera. With flash, there is no lag time, and when an

insect breaks the beam the flash fires virtually instantaneously.
Actually, several flashes fire, as I'm using wireless transmitters
to fire several flashes for more attractive lighting. The flashes are
set to a Power Ratio of 1/64, for an extremely fast flash duration,
necessary for fast-flying insects shot at macro magnifications.

As | sat in my office writing this article my attention was
constantly diverted to a constant stream of songbirds visiting the
feeders just outside my window. Last winter I took the time to
finally photograph some of the birds we ve enjoyed for years.
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Although we feed the birds daily we’re not
out on our porch when most of the birds
visit, and I suspected birds would be a bit
shy if' I was simply standing around, and I
didn’t have the time to waste finding out.

Instead 1 set up a photo blind on my front
porch, which not only minimized the
chance of disrupting the birds’ visits, but
also would help to keep me warm on a cold
winter day. I added a couple of branches
and weed seed heads around the feeder

for attractive perches and gave the setup a
couple of days for the birds to get used to
the change.

Birds that are accustomed to visiting

a feeder may not utilize even the most
beautiful perch immediately. They have

a routine, and if vou’re working around
vour home 1t’s wise to give the birds time
to change their habits. A lot of people
don’t, and they get discouraged quickly
when their grand plans to take bird pictures
don’t materialize immediately. A couple of
days later I spent several very productive
hours inside the blind, capturing images of
subjects ["ve ignored for years.

This summer, for the first time in years, I'll
be home for several months. While I know
I'll have the usual office distractions, I've
vowed that I would take the time to enjoy,
photographically, all the opportunities

I have just outside my office door. I'd
encourage you to do the same!

Joe McDonald has been photographing
wildlife and nature since he was a high
school freshman and was selling his photos
fo the National Wildlife Federation. He
has been published in every natural history
publication in the U.S., including Audubon,
Bird Watcher s Digest, Birder s World,
Defenders, Living Bird, Natural History,
National and International Wildlife, Ranger
Rick, Smithsonian, Wildlife Conservation,
and more. He is the author of nine books
and one e-book. Joe is especially well
known for his expertise in electronic flash
and using equipment for high speed flash
and for remote, unmanned photography.
For more information, go to: www.

hoothollow.com
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TEN
WAYS

To Get Out Of Your Own Way & Be A Good Photographer

BY CHELSEA WILLIAMS

have learned a lot of things about photography the hard way. One
should learn from someone else’s struggles. In this case learn from
mine and be a better photographer.

1. Make friends with other photographers - Starting out you have this idea that everyone

1s against vou. At least 1 did. I looked at all the other photographers that I saw as scolding and
disapproving. They were “Let’s face it better than me photographers’. 1 steered so far away from
them that | was literally an island unto myself. Isolation doesn’t make great personal or business
sense. Once | realized that the other photographers | met where actually wonderful, kind and
helpful professionals, it opened up my world. I can’t count how many times a lesson was learned
from the person sitting next to me at a workshop. They taught me more than the person speaking.
Make friends with a professional photographer that you can to talk to and, bounce ideas off of.
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2. Find a mentor - This is beyond making friends with a photographer. Find a
photographer who has already achieved success and learn from them. Starting
out I always knew 1 needed a mentor. There was so much I didn’t know, and

I was literally waiting around for someone to teach me. | had it in my mind
that some amazing photographer would find me, take me under their wing and
like a fairy godmother transform my career. Well that never happened! A few
things wrong with that. I was not taking control nor responsibility for my own
learning. People that are successful at what they do work very hard to get there.
They are not going to give their valuable time away for free to show ‘“little ole
me’ how to do my job. Nor, should they. Find someone you look up to, who

is good fit for your career plan and pay them to mentor you. You might also
develop a great friendship out of it.

3. Invest in Education - | have discovered through continuing my education
how much more there 1s to learn to grow as a professional. The truth 1s that you
are never going to get better just by repeating the same processes. In this world
educational options are unlimited. Do not create excuses for yourself. There are
online streaming classes, online workshops, in person one-day workshops like
the “Texas Ten’ or week-long workshops like “Texas School’. | can honestly
say that I have learned more about business and portraits in one week at Texas
School than from my four years of my university photography. The university
taught me basic skills and art. Texas School taught me how to operate as a
business. I very highly recommend a week long intensive workshop 1f you can
swing it. [f you can’t, take one Saturday out of your month or one hour out of
your day to learn something new.

4. Network - | know that social media is the hottest concept now, and that
social media will be part of our future. You're on Instagram. “fantastic!™ Did
you get any today sitting at home browsing Instagram and snap chat? Get
involved with yvour community. This is where you live, this 1s where your
potential clients live. Go meet them. Contact vour local chamber of commerce.
Google networking events in your area. You don’t have to join everything.
Just go to visit and meet people. Get your face and your brand in front of other
people. If you have zero bookings then get up, dress up, go introduce yourself
and be genuinely interested in everyone you meet until you get a booking.

5. Your clients care more about who yvou are than price - Stop talking about
price all the time! Most of yvour clients don’t really care. Yes, they will ask but
that 1s a default question for them. What they really want to know is: whether
you know what you are doing? Can they trust vou? Will you make them look
good? Will you make them feel comfortable? Do you value the same thing the
customer values? Explain your process to them. Show them examples of your
work, Show them testimomials if you need to. Show interest and talk to them
about their family. Relate with them and have a real conversation. Establish a
connection with your client.

6. Make the experience enjoyable - Earning money is great! However, | have
noticed that when I am photographing paying clients for an extended period

[ get very focused on just making them happy. | forget to have fun! I love
being a photographer and | want my clients to see that. [ try to incorporate one
shot at the end of each client session that 15 creative just for me. It keeps me
refreshed and excited for my clients. Also, don’t limit yourself to only shooting
clients. For instance, if you love landscapes and flowers then schedule yourself
time to go on a hike and shoot landscapes and flowers. If you want to try a
contemporary style vou don’t currently shoot, just do it! Try and shoot at least
one thing for you per month. It will keep your creativity flowing and all around

happier.

7. Work with what vou have - This may be the number one thing [ wish 1
had truly taken to heart sooner. It is so easy to see how other people shoot and
equipment they use and think that vou must copy their style or process. You
believe ‘that’ vou WANT that. Instead. create a vision board and put a new
lens, camera, lighting system, outdoor landscaping on there. You should create
something to work towards. Don’t give up if you see an advanced photographer
using six lights to create a shot or incredible image while vou are just using
natural light and your camera. If vou have a reflector use it. If you don’t, make
one. It 1s pretty easy. Do you have only one strobe light? Perfect, then practice
with it. Learn how to bounce light off of a white wall to get the light you need.
You only have a tiny bedroom with a window? Get creative. | have seen some
Rockstar photographers that have started in studio apartments shooting with
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natural window lighting. They
weren’'t embarrassed about it, they
owned it. Don’t use what you don’t
have as an excuse. Remember to
invest in education and learn how to
develop what you have.

8. Practice - [ think this 1s hard for
photographers. We are constantly
told not to give our work away

for free. That 1s kind of a “Catch
22" when you’re starting out and
trying to build your portfolio. You
need to practice and practice often.
Photograph your family, cousins
or neighbor. Promote a model call,
find someone to shoot for a shoot.
You can’t sell portraits 1f you do
not have portraits to show. No one
wants to hire an inexperienced
photographer that no one knows or
1s not using. How do you offset developing experience by not giving your work
away for free? By being strategic in who you choose to practice with. Don’t do
free work just because someone asks. This can be a never-ending pitfall and
the potential for business exposure can be tempting.

Treat your portfolio clients as real paying clients. They may get something for
free. but it doesn’t have to be everything. You still need to be professional. The
crucial point is continue flexing your photography muscle. You can include
something for free and still stay in control of your business.

9. Everyone wants to give up - | don’t think | have ever met a photographer
who loved their job and thought they were awesome every single day.
Everyone has days where confidence slips. Honestly, I think this can apply

to every profession. You’re going to have bad days every now and then. Lick
your wounds and move on. When unexpected things happen, evaluate what
went wrong. Own your work and accept responsibility for it. Learn what to do
and what not to do different the next time. Keep going.

20

10. Be in control of your time - When [ first started out, there would be
several weeks without a client and then bam., bam. bam. A bunch of clients
wanted to book all at the same time. | thought I needed to schedule all the
work I could. The impulse reaction was to satisfy the clients schedules and
agree to photograph all of them on the same day. Oh, and then | needed to rush
and get these client’s images edited right away. I had so much going on that |
felt as if | could not get it all done. Then the next week was back to erickets. |
learned that just because they all called and asked 1f I could photograph them
on the same day did not mean that they all NEED the same day. Remember
that you are the boss and you get to set your own schedule. Do not rush your
work just to satisfy someone else’s schedule. It is as simple explaining that
you are already booked on that day and offer an alternative date. Most of the
time, an alternative date will be totally fine. Controlling the schedule will leave
you better rested and better prepared. Quality will bring more consistent work.
Editing three or more sessions all at the same time cannot be done proficiently.
I am doing better quality of work by controlling my own schedule. | DON’T
have to stay up all night editing. The client may WANT their images the next
day, but do they really have to HAVE that? You need sleep, you work better

with sleep. Be in control of your
time. Space it out. Everything will
be fine.

Chelsea has quickly become
the “go to photographer” for
Headshots and Beauty Portraits
in The Woodlands area. She has a
bachelor s degree in photography
Sfrom Sam Houston State University
and is an active member of the
Frofessional Photographers of
. America and Texas Professional
- Photographers Association.
Chelsea was also one of the Texas
10 Workshop instructors in March.
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Summerfest is a Hit
Here’s Why!

La Torretta Resort and Spa

This resort is a family vacation destination on Lake Conroe. It features an 18-hole golf course,
12,000 square foot spa, fitness center and an impressive water park. The Aqua Park is home to La
Torretta Lake Resort’s multiple pools featuring an elegant heated upper pool with an infinity edge
that cascades down into a 6,400 square foot Mediterranean pool. Other pools include the Breeze
Buster pool, Lay-Z River™ Rapids and the Splash Scape pool with an in-water playground, and
the Pollywogs pool for the youngest of water lovers. It offers the best way to beat the Texas heat.

Dining options include the Coco Cove Poolside Grill, the Yoi Sushi Bar and the Lakeside
Restaurant and Bar, just to name a few! There 1s a piano bar, a coffee shop and the Energie Lounge.
Check out the many dining options at the La Torretta website: www.latorrettalakeresort.com.

The kids wall be thoroughly entertained at the Aqua Park, but when it’s time for some dry fun away
from the pool, the activity options read like a novel. There is an arcade, miniature golf, and movie
nights by the pool. They will enjoy putt-putt, a teen hang-out with video games, making s’mores
and other organized activities and games throughout the day led by the La Torretta staft.

Family Fun with TWO FREE PICNICS

After a hard day of water slides, golf, hanging out in the lazy river, going to the spa and learning
photography, you and your family are going to need to find something fun to do! That 1s why we
brought back TPPA Family Fun Night! Family Fun Night i1s on Sunday night. You and vour family
are invited to join us at the TPPA Lakeside Villa for our 1st picnic. The fun starts at 6:00 pm.
Bring your lawn chairs and blankets and a cooler of your favorite adult beverages and enjoy the
picnic sponsored by our wonderful vendors.

Meet the Vendors

After the picnic on Monday evening, head over to the conference center to meet the vendors and
check out the great deals and specials. These are the folks who make all of this possible, so come
and find some fantastic deals on everything you need for your photography.

TPPA Annual Photographic Awards Presentation

Join us on Tuesday at 6:15 pm for an evening of surprises! We will begin with the children’s
awards for the Kids Foto Kontest. Every kid who participates will be recogmzed and we will
announce the winners from each category. The excitement continues as we announce and unveil
the winners from the TPPA Annual Photographic Competition. Tickets to the event are only $28
and include a buffet dinner. Kids tickets are only $17. This will be an event to remember. So, bring
the entire family!

Every guest room at La Torretta is a suite! The room rate for TPPA Summerfest attendees 1s an
unbelievable $112 per night. As an added bonus, if you book your room by June 1st, you will get
your La Torretta Resort Fee (normally $30) ABSOLUTELY FREE with your stay at La Torretta!
Don’t miss out on this huge money-saving offer. Register now and reserve your suite at www.
TPPA org/summerfest. Just staying in your suite is a vacation in itself.

Golf Anyone?

As you enter the La Torretta Resort property, vou get your first glimpse of this beautiful golf
course. We know you will delight in the beauty and the challenge of the course at La Torretta. On
Tuesday, around 8 am, the 25th Annual TPPA Golf Scramble tees off. If vou have never played
with this group, come on out and make new friends and see what all the fun 1s about. Registration
for this event is $65.
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he purpose of the TPPA Image Competition is to allow

photographers to enter photographic images to be judged against
a Standard of Excellence and to assist the entrants in preparation for
PPA District or International Photographic Competition. Those who
enter are eligible for awards and TPPA points that apply toward the
Associate Fellowship and Full Fellowship degrees within TPPA.
Although the complete rules and entry forms can be found online at
www. TPPA.org/Summerfest, here are some of the highlights.

Entrants may submit physical prints and/or digital images and
multiple album (any event) entries, physical or digital. Each album
counts as one entry. Each “case™ may contain up to eight entries. All
entries must be uploaded/registered at www.printcompetition.com.
Click on “Free Registration of a New user™ or simply log in if vou
already have an account. All images/albums must be named before
uploading. You will then need to deliver your physical prints and/
or album to the print room in the La Torretta Conference Center by
9 am on Sunday, June 24th. Image sizes and other specifications for
physical prints and albums will be posted in the official rules on the
website.

Also be aware that the entrant’s name shall not appear anywhere in
or on the face of the entry and no entry will be eligible that has been
made under the supervision of an instructor or as a class assignment.
In addition, no two entries shall be of the same subject, even if the
subject is not a dominant subject in the image. Once an image has
scored 80 or above, it cannot be entered again at the TPPA Summer
Seminar Image Competition.

TPPA is committed to creating excellence for TPPA members and
has invested in an IPC caliber station for judging digital entries. This
station includes three judging monitors, a dedicated computer and
software to run the competition, and the ability to project images
being judged onto a big screen for the audience to see.

Finally, each year there is a special trophy presented to the maker of
an image that best captures the TPPA President’s Theme. This year
that theme is “Class of 2018.” The selection is made by the TPPA
President from the general exhibit after the judging.

The annual image competition is a great learning experience for

any photographer who wishes to excel at their craft. Watching the
judging itself will provide you with a new insight that will boost your
confidence and broaden your knowledge of image making. What you
will discover is that others who have participated for years are more
than happy to help vou throughout the process. But you won’t learn it
if you don’t participate and the best way to do that is to JUST DO IT!

Details at: www.TPPA.org/summerfest
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Image Competition
Your Chance to Shine

Register for Seminar, Your Room, & Print Competition at

www. TPPA.org/summerfest

[mage (bmpetition
BOOT CAMP

with Mark McCall

We want to take away the fear you may have of entering photographic
images and get you prepared for competition and to see you eaming
those trophies and awards. TPPA believes that participating in the image
competition process and earning those PPA degrees help improve your
chances for success and sets you apart from the crowd. We want to see
you succeed!

Image Competition Boot Camp runs Sunday, June 24 from 10 AM -
Noon, continues from 2:00 PM - 5:00 PM.

Image Competition Boot Camp is FREE with your registration to
Summerfest. Space is limited, so register early!
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Aileen Harding’s

FINE FEATHERED FRIENDS

by BILL HEDRICK

Persnnal trial and tribulation 1s often a great motivator in shaping one’s future. While caring for her mother after a debilitating

stroke, Aileen Harding was sorting through some of her mother’s old photographs and found one of her parents on their wedding
day. Each one was filled with love and promise. It was at that moment that Aileen decided that everyone needed good photographs to
commemorate their own lives and that she needed to learn how to create them. Digital photography was coming on the scene and she

was hungry for knowledge, so she spent hours online with Kirk Voclain’s Produm. Soon she learned about PPA and the Professional
Photographers of Houston and enrolled in the Texas School of Professional Photography. She was on her way.
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It was in 20035 that Aileen opened her residential
studio in Baytown, Texas. It was small but she
averaged around 30 sessions per year, primarily
seniors, families, and some pets. But her exposure to
her local guild made her hungry to learn more.

“Watching print judging for the first time changed

my life. I never knew images could be so beautiful,”

she says. “It gave me a goal and provided me

guidance from various mentors. Because of this, the

Houston Guild has been a big part of my life for the '

past 12 years.” In 2012, Aileen entered her first IPC

competition and three of her entries were accepted in .
the Loan Collection. She was hooked.

“I've always loved birds,” Aileen recalls. “Living along a major migratory
path for birds passing through for the winter, gives me the opportunity

to enjoy birds year round. Songbirds, Raptors, Hummingbirds, Sandhill
Cranes... they all travel through and many of them choose to stay awhile.
But, living in the deep South also means there are lots of great birds to
see all year-round. The older I get, the more I enjoy quiet time and just
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watching them while listening to the wind in the marsh grasses and
feeling the warm sunshine. But I especially like to photograph the
larger water birds.”

Going all the way back to her film camera days in the 1990°s, Aileen
loved photographing the Blue Herons. “They were my favorite bird at
the time, with their various shades of blue. Currently, my favorite is the
Reddish Egret. They make me smile as they dance in the shallows for
supper, throwing shadows with their wings to make the fish scatter, and
snatching them up with their pointed beaks.”

Photographing these beautiful creatures is also a tremendous stress
reliever, as Aileen points out. “I love to go to the bay and roll down my
windows and feel the wind and listen to the bird calls. Getting to see
their different personalities is my idea of relaxation.”

Her technique is relatively simple. Aileen does not use blinds or setups.
Instead, she goes to the rookeries during breeding season or along the
marshes to find the birds in their natural habitats. “We have several
bird sanctuaries in our immediate vicinity and nearby in the Galveston
area,” she explains. “When doing wildlife photography, it is always
best to shoot during the “golden hour,” just before sunset or just after
sunrise while the light is soft, diffused, and directional. As the sun rises
in the sky. shadows become harsh and images are not as pleasing.”

She also points out how important it is to understand where the light
direction will be in regards to the subject matter. *The same rules apply
as in studio lighting,” says Aileen. “You will want directional lighting
that gives depth and dimension to your subject. But, while you can
create beautiful images in this scenario, your window of opportunity is
going to be fairly limited.”

A good source for planning vour own wildlife photo excursion is The
Photographers Ephemeris (TPE). This app shows where the sun and
moon will be and where the light will fall at any time, for any location
on earth. “This is a great way to plan the optimal time to photograph
at your chosen location,” says Aileen. “Plumage is always best during
breeding seasons and this is when photographers come from all over
the world to photograph the rookeries along the Texas Gulf Coast. Of
course, Egrets and Herons can be found almost anywhere and they are
spectacular during breeding season.”
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After you've figured out what type of birds you

want to photograph, where they are, and how they
behave, it is time to consider the technical aspects of
bird photography. Lens choice is extremely critical

in bird photography as well. “Consider whether you
are shooting full-frame or with a cropped sensor.

A general rule of thumb is that you should have a
minimum focal length of 400mm. Of course, it all
depends on how far away the birds are and how much
of the environment you want included in the image,”
she says. To “tell the story,” Aileen usually shoots
from 400mm to 600mm, using a fixed (prime) lens for
maximum sharpness.

Aileen also highly recommends a sturdy tripod
designed to hold a long lens. “Be sure that these
items are rated for the weight of your camera and
lens. Choose a head that allows you to pivot your
camera to follow the birds in action. This would
usually be a Gimbel or Wimberly Head, but I use a
ProMedia Head that 1 purchased at the Imaging USA
Trade Show at a great discount. Hand-holding a long
lens and creating a sharp image is very difficult, if
not almost impossible. Remember that the slightest
movement becomes obvious when shooting at
400mm or more.”

Other tips include paying particular attention to the background. “Make
sure it enhances and doesn’t distract from the subject. Ask yourself if the
background and composition help to tell the story. Then photograph from
eye-level if at all possible. This creates a more compelling image. If you
plan to enter your image in competition, keep in mind that there seems

to be an unwritten rule that birds must be entirely in focus from wing-tip

to wing-tip and throughout the body. But, for other well-known national
photographic competition, a little wing blur is preferred as it creates a more
dynamic image.”

For birds in flight, Aileen recommends that the focal point should either
be center-focus or use dynamic auto-focus. *You will want to choose an
aperture that will give you sharpness throughout. So, whenever possible,
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1 try to shoot at £8.” Continuous auto-focus, with a shutter speed priority of
1200 to 4000, depending on the type of bird, direction of flight, and speed
of flight, is also recommended.

If all of this is intriguing to you, Aileen recommends you first decide what
kind of birds you want to photograph. Then find out where they hang out
and learn about their behavior. “There are a number of great resources for
this. You can join local birding groups or the Audubon Society in your area.
Google can be vour best friend when doing this research,” she explains.
“And don’t forget, you can always put up feeders in your own yard. That’s
the easy way to photograph birds!™

Aileen Harding received her Master of Photography in 2015 and her
Photographic Craftsman in 2017. She is
also Chairman of the Board for PPG of
Houston. In 2016 and 2017, she racked up
honors including PPA Gold and Platinum
Medalist of the Year, TPPA Best Illustrative
and Best Wildlife Image by a Master,
among others.

Her current goal is to qualify for Imaging
Excellence next year. From what we’ve
seen so far, we're betting she does.
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Discover Texas School

www. TexasSchool.org
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FULLCOLOR

Professional Printing Services

Each Canvas Block utilizes a wooden box-frame
and has a solid surface on the front and sides.
This method creates a sturdy structure to

support the canvas, and makes for extremely
tight corners with no folding overlap.

MARCH 29 - APRIL 24

With USB
Tin Purchase

(Must order UISB drive with tin.)

MARCH 29 - APRIL 24

PRINTS & FINISHING « PHOTO ALBUMS & PRESS BOOKS www.fullcolor.com
GALLERY WRAPS & FINE ART - METAL PRINTS 800.382.2101

PRESS PRINTED PRODUCTS « PHOTO GIFTS «» SPORTS
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ave you tried the Color Lookup adjustment layers? Although it has

been included with Photoshop for some time, i1t’s one of those features
I've repeatedly overlooked until recently. Color Lookup adjustment layers
are commonly used by video editors. I discovered their value when [ was
researching online tutorials looking for an effective method of creating a
night for day look for an image. 1 researched a number of tutorials that I
found time consuming and unnecessarily complicated. As I continued to
search, | stumbled across the Color Lookup adjustment layer that I'd never
used before. It is one of the many features in Photoshop that we tend to be
invisible until we know about them.

A Color Lookup table (LUT file) is most commonly used for color grading
by videographers for remapping the colors in an image to another set of
colors. It essentially allows you to alter the color, contrast and brightness of
an image with a single adjustment laver. My first use was for an easy night
from day effect - a simple one click solution that was visually effective and
vastly quicker and easier to use than many other relatively complicated
techniques. I work visually and have no reluctance to using an easy one
click solution instead of reinventing the wheel. In essence, a color look

up adjustment layer allows us to store a set of multiple adjustment layers
into one single adjustment laver. You can use the already available presets
by adding a color lookup adjustment layer to a file and selecting a look
from the drop-down menus in the properties dialog box. One click applies
the look which can then be adjusted with opacity, layer blending modes. a
layer mask, and even additional adjustment layers. You can add multiple
ColorLookup adjustment layers as well other adjustment layers.
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by Thom Rouse

. I

Texas School Instructor

In these examples I used a simple fashion shot. Figure 1 is the original
treatment, figures 2, 3, and 4 utilize the Night from Day Color Lookup
adjustment laver with some layer masking and different layer blending
modes. All were achieved far more quickly than individual treatments to
each image which would likely have required three or more individual
adjustment layers to achieve. Instead, a single Color Lookup adjustment
layer was used on each.

There are approximately 40 different looks stored in the 3 color lookup
drop down menus in the properties dialog box. You’ll find them in the
adjustment layers palette or in the drop down list under the half circle at the
bottom of the layers palette. Simply add a Color Lookup adjustment layer
and explore the looks under the drop down menus in the properties dialog
box. The examples here illustrate the NightFromDay.cube look from the
3DLUT drop down menu. In addition to those already stored in Photoshop.,
there are many others available for free or for purchase on the internet.
Simply do a search for downloadable color look up tables for Photoshop.

But wait - there’s more!!! Have you ever spent a great deal of time creating
a look for your image using multiple adjustment layers, opacities and
blending modes? You get it just right and love the look, but when vou try it
again on a different image, you neglected to save the unflattened files and
forgot exactly how you did it. Instead of working desperately to re-create

a look or sliding in adjustment layers from prior projects, just get a look
you like and export it as a Color Lookup table (LUT). Although vou could
record an action for all your adjustment layers, exporting a LUT allows you
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Properties

E n Color Lookup

to save it with one click and apply it to
any other image you wish.

To save a LUT, simply work on your e JelbAl
image until you get a look you like using
adjustment layers, opacities, and layer
blending modes. The image must have

a locked background layer (Any work
you’ve done with layer masks will not
be included in the file). Then, select File
> Export = Color Lookup. Select any or
all formats, but I would suggest saving
them all - 3DL, CUBE, CSP, and ICC
profile. The ICC profile allows use on
other software and devices and is stored
differently than 3DL, CUBE, and CSP.

) Abstract
Device Link

3 Dither

Data Order

A description and copyright info in

the export dialog box when saving a
LUT. A medium 32 grid point should
be sufficient, but you can go to 64 or
128 for higher quality with significantly
increased file size. Click OK and save to
a selected folder. When you want to use
your saved LUT, add a Color Lookup adjustment layer to an image and,
in the properties dialog box, click on 3DLUT file to load your saved file.
Navigate to your saved LUT folder, and press OK. You'll immediately
have the look you’ve saved with one click instead of having to drag and
drop multiple adjustment layers or recorded actions.

You can utilize the layer mask in the adjustment layer as well as change the
blending mode and opacities. I've found that using the CUBE file allows
you to change the *Data Order” and the *Table Order” in the Properties
dialog box for some interesting alternatives for the look. I'm uncertain
about exactly how or why this feature works but I work visually and

I’m happy to leave the technical details to the engineers. If you are truly
interested, I would suggest searching Julieanne Kost’s blogs. If anyone
knows, she will.

To add your LUT to the drop down menu

test3.cube

Load Abstract Profile...

Load Devicelink Profile...

Table Order

() RGB
O BGR

work flow when you’ve achieved a look that works on a range of images.
But for those looks yvou’ve created that are very image specific, having the
ability to adjust each of the original individual adjustment layers may be
useful.

Thom Rouse, a Texas School '18 instructor, began his career as a portrail
and wedding photographer in 1994. Based near Chicago, he now divides
his time between commercial, fine art and commissioned fine art images
with his clients as the central subject of his pieces. His conceptual fine art
images utilize real world photographs, blended and manipulated to create
an alternative to real world perception. Thom also lectures and teaches
workshops on topics ranging from Photoshop as an artist’s tool, visual
literacy and lighting and posing for figure studies.

in the properties dialog box, copy your
LUT file and paste into: Applications >
Adobe Photoshop (CC 2017) > Presets
> 3DLUTs. The next time you open
Photoshop your LUT will appear in the
drop down menu. Your saved LUTs can
be used in any application that supports
LUTs including Adobe Afiereffects,
Premiere, and many others.

Description:

Copyright:

Quality
Grid Points:

I would be remiss if I didn’t point out
that Color Lookup adjustment layers are
not the answer to saving every look you S
achieve in your images. In some cases,
the adjustments made to each adjustment
layer you’ve added may be very image
specific. For cases in which you’ve done
a lot of work on an image, 1 suggest
always saving a lavered file with all the
adjustment layers so that you can drag
and drop them into another image. In
many cases, utilizing the Color Lookup
adjustment laver will offer a quick one
click solution and significantly speed

Formats
3DL

04 CUBE
CSP

ICC Profile
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Export Color Lookup Tables

DSC01472-

Cancel

4 Use lowercase file extensions

Medium
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We offer over 80 stocked frames and thousands of custom order frames
to accent your beautiful photography and match your
client’'s home decor.

Visit acilab.com/frames-mats to see all of the options!
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American Color Imaging | www.acilab.com | 800.728.2722 a ( I
Thank you to © Captured Moments Photography by Jason and Kate Higdon for the beautiful family images.




SAME INCREDIBLE SUPPORT, NOW FASTER THAN EVER. X
Introducing next-day service for CPS Platinum members. ca“ Oon

SEE IMPOSSIBLE
For complete terms & conditions, visit cps.usa.canon.com

©2018 Canon USA, Inz. Al rights reserved Canon is a registered trademark of Canon Inc in the United States and may also be a registered trademark in other countnes
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AKING CREATIVE
NAME BADGES

by ROB HULL

Texas School Instructor

Corbell Photographic Woikshops

f you've ever wanted to make some good looking name badges for an event, chances are you created a nice Photoshop file and spent
hours editing the text layer that had the person’s name. Edit, print, edit, print, edit, print, and on and on. But, there is a better way
and it’s been hiding in Photoshop for yvears. You can create hundreds of variable images in just minutes!!

Photoshop now supports data-driven graphics, a fancy way of saying “OMG, | can make a hundred name tags in just a couple
minutes”. And we re not just talking name badges. I can dynamically replace text, pixels or even hide and reveal layers based on
the contents of a data file. Using this technique, | made name badges for everyone on our Ireland Tour and I could do it in just a few
minutes. Let’s look at what steps I went through to accomplish this.

Here are the Step-by-Step procedures. ..

Create your graphic

The first thing to do is just design the name badge. In my case, [ used a
background image and then created a text layer for the person’s name and
one to indicate where they are from. I used a font that looks Celtic and
applied some layer styles to make the text pop. [ also named each of these
layers. They will show up in menus later so it helps me keep track of what
each layer contains. Layer Location *
Yarabie Type
Define Variables Vasiny

Define the variables in your document

In our sample here, we want to use variable data for the person’s name

and the City/State. Once the layers are created and named we just tell
Photoshop that those layers will be replaced with variable data.

Text Replacement

Mame.  Locathon

1. Go to Image > Variables > Define.

2. Select one of the layers with content that you’d like to define as a
variable. In our case, the name or location layers. Deacripsion

3. Define the type of variable - for the name badges it’s Text awre et b o o dwf = reaz i
Replacement but look, oh veah, there’s a lot you can do with this. ‘

4. Define a name for your variable - there are some specific rules but
basically, no spaces or special characters. Use all alpha characters and
you won't have a problem.

5. click OK.
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Import Your Data Set

Use the Define Sets dialog to Import your data file. Now that Photoshop
is ready to read all the data, we need to import the data file with all the
detailed information. Photoshop wants to read a simple text data file.
Either a comma-separated (CSV) or tab-delimited file. If you've got the
information in an Excel spreadsheet, you can easily save the data as a
comma-delimited file.

Make sure you have a column name at the top of each column of data. |
like to use single words, no spaces. It just makes things easier. This name

should match the name used to define the variable layer in Photoshop.

1. Go to Image > Variables > Data Sets
2. Select Import... and select the data file you created above.

New... HN

Open... X0

Browse in Bridge... XXO

Open as Smart Object...

Open Recent >

Close ®wwW . . .

Close Al W Generate Graphic Files Using Data Sets
g:: abert oo o e:: Generate your individual files by going to File = Export > Data Sets as

B oORS Files... Once }fﬂlu"wlfe ldeﬁned the variables and the data sets you can now
generate all the individual PSD files.

Revert Fi2

Quick Export as PNG 1. Select File > Export > Data Sets As Files
Generale > ExportAs... NORW 2. Enter the base name you want for all your files.
Share on Behance... inati '

it Pl 3. Select a destination directory for all your files.
Search Adobe Stock... - 4. Choose the data sets to be exported.
Place Embedded... Save for Web (Legacy)... XS 5 Click OK
Place Linked..

Photoshop will only save PSD files so if you want these images as JPG, or

Automate > some other format, you’ll have to batch process them. That can be done in
Scripts > '
Imp::ﬁ S LayerstoFiles.. Photoshop or Lightroom.

Color Lookup Tables...
File info... Xox \ Once exported, all your files will be placed in the folder you indicated as
Print... xp Paths 1o IBustrator.. individual .psd files.
Print One Copy TOoXP Render Video..,

Zoomify... For more detailed information about this, check your Photoshop User

Guide and search for “Create data-driven graphics™.
L L Cutped Files
Bl & v
Qurgrd Flgn *
T oropian
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(3 Cotercer Rob Hull, M. Photog.Cr., CPF, started
Y O Great Photography over 20 years
(23 Doten Fo m [ Ty | ago in Coppell, Texas. In that time,

- o . ‘I ; III he has offered commercial, portrait,
£ oo Light..

and freelance services to thousands

2 GrmatPnes. ;
£ Oveatphet. of clients. This year he teams up with
I7) Drmtes . I - Tony Corbell with “Between Light &
7 GrostPrat. Shadow " at the 20118 Texas School of
SRR i K :_,:...11-._-_...;,',1, SRR Rt Professional Photography.
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SIGMA

WIDE LENSES.
WIDE RANGE.

With their high-level optical performance, Sigma'’s
range of wide-angle Art lenses offers expanded
creative opportunities.

O Art
14mm F1.8 DG HSM

O Art
20mm F1.4 DG HSM

O Art
12-24mm F4 DG HSM

O Art
14-24mm F2.8 DG HSM

O Art
18-35mm F1.8 DC HSM

SIGMA USB Dock

Update, adjust & personalize. Customization never
thought possible. Sold separately.

Learn more sigmaphoto.com/usb-dock

USA 4-Year Service Protection. Handcrafted in Japan. Our entire line-up on sigmaphoto.com

SIGMA Corporation of America | 15 Fleetwood Court | Ronkonkoma, NY 11779, U.S.A. | Tel: (631) 585-1144
Follow us on Instagram @sigmaphoto and Facebook.com/sigmacorporationofamerica



Spotlight
Pics

42

A gallery of images submitted by members of TPPA and others, Spotlight Pics is o means of
sharing great images, ideos, and techniques with fellow photographers. To submit an image,
go to ThePhotographerOnline.com or email the Editor: Editor@ThePhotographerOnline.com

“The Executive™ was created by Jen Hargrove of Big Piney, Wyoming, while she was teaching at a Super
Monday class in May of 2017. Jen used a Nikon D810 and a 70-200mm 2 8 lens. Lighting consisted of a 50 inch
Westcott Apollow Soft Box at camera-left for the main light and a 42 inch shoot-through umbrella at camera-
right. “We were demonstrating the use of simple props to help with storytelling in a simple image for print
competition,” she explains. “The subject 15 Fynnegan, a four yvear old English Mastiff who 1s a regular fixture at
our studio. We actually create images of him every few months. [ was fortunate that he was focused on the other
dogs in the studio and gave that great expression.”
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WAIT-LESS WEBSITES

Choose a design that's ready for your
photography and launch it FAST
(with time left over to finish that donut)!

PHOTOBIZ.COM // 866-463-7620
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IMAGE BY PAMELA STEEEE

For a short time only BWC is offering introductory pricing on FUJIFILM

these unique Photographic Papers in width up to 20 inches.
Give your image the look and feel it deserves.

Fuji's NEW Photographic Textured Papers:
LEATHER, CANVAS, LINEN & DEEP MATTE VELVET

Call Anthony or Jeanie for your introductory pricing TODAY!

PRINTNRRERS

dallas | 1.800.445.0264 | bwc.net



